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About Web Verifier 

Web Verifier is a web-based extension of the Verifier Client. 

This application allows users to verify documents without having software installed on the client side. 

The processing of activities primarily occurs on a central server allowing use of thin client devices running 

only a web browser. 

About WebCenter Forms Recognition Workflow 

In WebCenter Forms Recognition, the flow of incoming documents follows a sequence of standard 

processing steps. One of the objectives of WebCenter Forms Recognition is to get documents to their 

recipients as quickly as possible. 

Runtime Server executes automatic steps that include document import with batch creation, OCR and layout 

analysis, classification, extraction, export, and clean-up. After the automatic steps there are two manual 

verification steps for quality control. 

If Runtime Server detects that the batch contains invalid results, the user manually analyzes and resolves the 

problem. Invalid batches appear in a task list called Batch View. When WebCenter Forms Recognition 

finishes processing a batch, the documents are sent to their recipients. 

Explanation of Terms 

To properly ensure the quality of automatically processed documents, it is important to understand the 

following information. 

Batches are the basic entity. 

WebCenter Forms Recognition works on batches and will completely process one batch before processing 

the next. Verifying and approving entire batches before routing to subsequent systems is an important step 

since batches are the basic entity. 

A batch is only valid if all of its parts are valid. 

Since WebCenter Forms Recognition deals with information and data, the application uses the terms “valid” or 

“invalid” instead of “working” or “damaged.” The restrictions on the number of parts and the well-defined 

relationships makes it easy to understand why a batch is invalid. 

A batch is invalid if: 

One or more folders inside the batch are invalid. 

A folder is invalid if: 

One or more documents inside the folder are invalid. 

A document is invalid if: 

The automatic classification result is incorrect or if the automatic extraction result has invalid fields. 

A classification result is invalid if: 

The class still needs validating or the matching class was not found. 

A field is invalid if: 
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The field content still needs validating, the field content does not comply with the validation rules, or filling-in 

the field is simply unfeasible. 

Reasons for violating field validation rules. 

 Restrictions on the number of characters. 

 Allows only uppercase characters. 

 Checking the questionable results from the OCR process, which are red and underlined. 

Helpful Terms 

Items 

Accumulated Learnset 

A common learnset is known as Accumulated Learnset. 

 
Automatic Supervised Learning 

This process uses the Associated Search Engine to process, classify, and extract information. 

 
Base class 

The highest level of a classification. 

 
Batch 

A batch is a stack of electronic documents. The electronic documents may be paper-based or files 

created using applications. 

 

WebCenter Forms Recognition Table Extraction 

An extraction method that facilitates interactive table training. 

 
Candidate 

Set of possible values for a field. 

 
Child class 

A class spawned by a parent class. Also called a sub-class. 

 
Class 

A set of documents that are grouped by common content. Each class usually has a mnemonic name 

that describes its contents. 

Common Learnset 

An accumulation of Local Learnsets. 

 
DocClass 

A parent document class. 

 
Document 

Any electronic file mainly consisting of ASCII text. If this is initially the case, OCR or filtering must be 
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applied to create the text representation classified, have fields used for extraction, and have one or more 

images attached. 

 

Export 

The system no longer manages documents released by the export function. 

 
Folder 

A logical structure inside a batch for coherent documents. For example, a folder may consist of all pages 

of a correspondence with many folders inside one batch. 

 

Global Learnset 

A general learnset that encompasses similar classes or projects. See also Local Learnset. 

 
Learning 

Given a view with a set of documents in vector representation and their class assignment, a neural 

network is created, so that the defined classes can be reproduced without error. This neural network is 

the used in all subsequent classification tasks. 

 

Learnset 

In classification, a learnset is a set of documents whose class assignments are specified by the user. 

For each view and each class, the user must provide a sufficient number of representative documents. 

Similarly, in extraction, a learnset is a set of documents whose field contents are selected by the user 

from a set of candidates. 

 

Local Learnset 

A learnset specific to a document class. 

 
Neural network 

An artificial neural network is an application that in some ways works like a human brain. This includes 

the ability to learn. It consists of artificial neurons that are linked into a network of layers. The neural 

network can receive signals through an input layer, process it within the internal layers, and send signals 

through the output layer. During learning, a specified input (called a teacher signal, such as documents 

from a Learnset) and the desired output (such as the corresponding classes) are presented to the 

network together. Processing is then adjusted until the desired output can be produced from the teacher 

signal. 

Optical Character Recognition (OCR) 

The reading and recognition of symbols of text from a piece of paper or a scanned image. OCR detects 

the symbols and converts them into characters and words that can be read electronically. 

 

Parent class 

A class with derived class, called children. 

 
Project 

A collection of customer settings for applications. Projects are created in Verifier and sent to Runtime 

Server for productive operation. 
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Smart Indexing 

Smart indexing uses a database lookup to determine document attributes. It can be used for automatic 

indexing and to support manual indexing. 

 

Sub-class 

A derivative class. Also called a child class. 

 
Workdoc 

An internal structure representing the logical structure of a document. The Workdoc represents the data 

created during processing of a single document and contains all OCR and analysis results. 

 

Processes 

Analysis 

Analysis means the document content is analyzed and a set of possible values for a field are generated 

called candidates. 

 

Classification 

Classification means assigning one or more classes and corresponding confidence values to one or 

more unknown documents. 

 

Evaluation 

Evaluation means determining a class or the contents of a field from confidence levels, weights, or 

distances for classes or candidates. 

 

Extraction 

Extraction means automatic document indexing and its information that helps to sort, file and search 

documents. 

 

Importing 

Importing means bringing documents into the system for management and processing. 

 

Indexing 

Indexing means assigning attributes to a document. This can either be done manually, semi- 

automatically (Smart Indexing), or entirely automatically (Extraction). 

 

Validation 

Validation involves confirming whether a processing result is correct. 

 
Verification 

Verification is related to quality assurance. It involves taking a processed document, checking the 

processing results, and correcting any errors. 

 

About Logging on to Web Verifier 
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Launch Web Verifier from a web browser using the server or application address. 

When starting Web Verifier on a machine for the first time, not all controls may be displayed. In this case, add 

the Web Verifier site to the trusted sites list of your browser. 

The project administrator assigns a user a name and password for Web Verifier. The user name and password 

also set the user rights for the active session. 

Log On to Web Verifier 

To log on to Web Verifier, complete the following steps. 

1. Open the login page of Web Verifier from a web browser. 

Note: The project administrator configures the login for Web Verifier by using either the Web Verifier 

login or Windows authentication. 

2. In the login dialog box, in the User Name field, type your user name. 

3. In the Password field, type your password. 

4. Click Log In. 

The name of the current user displays at the upper right corner of the Web Verifier window. 

About Windows Authentication 

Your administrator needs to configure the Web Verifier service to allow Windows authentication. 

The Windows authentication login for Web Verifier shows the following special behavior. 

 A canceled or failed authentication opens an error page. Press the reload button to open the Login 

window again. 

 You can switch to another user, such as the Administrator, by opening the File menu and clicking Re- 

login. The standard Web Verifier Login window opens. 

 Windows authentication mode prevents changing your password. 

 The Logout link terminates the session on the server. Reloading a Web Verifier page in the same browser 

instance creates a new session on the server for the current user. 

 In order to completely logout from the system, it is necessary to close all open browser sessions. 

Otherwise, returning to the starting page automatically restores the last session. A message screen at 

the end of the logout step reminds you of this: 

Thank you for using Web Verifier. To complete the logout, you may now exit 

all opened browser windows. 

Logging on Using Windows Authentication 

To log on using Windows authentication, complete the following steps. 

1. Open the Web Verifier start page. 

2. Complete your Windows credentials. 

3. When logged in, the Web Verifier window shows the domain and computer name in the top-right 

corner. 

Note: The Windows authentication form will not display if the current user is not configured for Web Verifier 

Windows authentication by the project administrator. 
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Troubleshooting 

Issue: If a user works with more than one active session, it might happen that the first session expires while 

the user is, for example, validating a batch in another session. 

In this case, an error message such as "Object reference not set to an instance of an object", might be 

displayed. 

Resolution: Return to the batch list and open the required batch again. 

Issue: Web Verifier is not working as expected after being setup. 

This could happen after Web Verifier has been setup and later it is not working. Web Verifier has a 

dependency on the WFR Core Service and WFR Runtime Server Service. 

Resolution: Make sure the WFR Core Service and WFR Runtime Server Service are up and running. 

Login Issues 

This topic covers issues that you may encounter at login. 

Maximum number of users exceeded 

There is a maximum number of users allowed to access the WebCenter Forms Recognition database 

at one time, which depends on the licenses. 

 

Session timeout 

To maintain the workflow with several Verifier users, a Web Verifier session ends automatically after 20 

minutes of no activity. 

Changing your Login Password 

To change your password, complete the following steps. The change password option is not available for 

users logged in with Windows authentication. 

1. From the Options menu, select Change Password. 

2. In the Old Password field, enter your current password. 

3. In the New Password field, enter the new password. 

Note: The minimum character length for a password is 7, the maximum character length is 20. The 

password must include both alphanumeric and numeric characters. 

4. In the Confirm New Password field, reenter the new password for verification. 

5. Click OK. 

About Configuring Web Verifier 

Configuring Web Verifier requires specifying which batches of documents are processed at a given station. 

This includes: 

 The Designer project file that contains the settings used to process the documents. 

 The name of the job that contains the batches to verify. 

 The processing steps that you want to perform: classification, extraction, document separation, or all of 

them. 
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 The status of batches before and after processing. 

You can only work with Web Verifier after these settings are established. Only experienced users should 

change the settings. 

Administrators assign users to groups that have specific roles. Depending on the group, the following settings 

are possible. 

About Groups 

Administrators assign users to groups that have specific roles. Depending on the group, the following settings 

are possible. 

Administrator 

For a default Administrator user with all of the available roles assigned, the Settings window displays all 

possible options. 

SLM and SLV roles 

Learnset Manager users with the Supervised Learning Manager and Supervised Learning Verifier roles, 

but without the Administrator role are presented without the Group Settings. The Supervised Learning 

tab is available. 

Verifier user 

For a default Verifier user, with the VER (Verifier), SET (Verifier Settings), and FLT (Filtering) roles 

assigned. Only the basic settings are available. Usually, the Administrator has already configured the 

Group settings with the project selected. Clicking the Default button adopts all settings for your group. 

The fields in all available tabs populate automatically. 

No Supervised Learning tab is available, and you are not able to edit Group Settings. 

If you want to configure your own settings, find the descriptions for the single configuration options as 

indicated in the following topics. 

About Roles 

Depending on their assigned role, users are able to complete the following tasks. 

 Define, modify, and maintain the learnset. 

 Collect and manage local training data. 

 Propose learnset candidates to improve the performance. 

 Verify the documents that Runtime Server could not automatically process. 

 Access and change the batch filtering properties. 

 Access and change the settings. 

For more information, see "Users, groups, and roles" in the Oracle WebCenter Forms Recognition Designer Guide. 

Specifying the General Settings 

To specify the General settings, complete the following steps. 

1. On the Options menu, click Settings. 

2. Optional. As an administrator, you can configure settings for different groups. Select Group Settings 
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and then select a group from the list. 

Note: Other users configure their own settings by selecting My Settings. For more information, 

see "About Groups" on the previous page. 

 

3. The project file contains the forms used to verify the extraction. To define the project that processes the 

documents, complete one of the following substeps. 

 To select a project file from the list, select Use project file and then select the required project 

from the Project list. 

The project loads after saving and returning to the Batch View. 

 To specify a project referenced in the batch control file, select Use batch specific project file. 

The project loads each time you open a batch and each time a batch opens for a different project. 

4. From the Job list, select the name of the job for which you want to process the documents. 

5. To select another language, from the Application Language list, select the required language. 

Web Verifier supports Chinese Simplified or Chinese Traditional, Danish, Dutch, English, French, 

Finnish, German, Italian, Japanese, Korean, Norwegian, Polish, Portuguese, Romanian, Russian, 

Spanish, Swedish, and Turkish. 

6. Optional. To automatically display newly generated batches with matching states, select Automatic 

Batch Refresh. 

If the option is cleared, you can use the Refresh  button below the batch list. 

7. Optional. To skip all the valid fields and focus on the invalid fields only, select Tab through invalid fields only. 

Note: When you press Tab inside a table, the system tabs through invalid table cells only. This option also 

applies for tabbing backwards by pressing Shift + Tab. 

8. To speed up typing, enable Enable text typing auto-completion. When you start typing, auto-text 

completes the word, suggesting the best match among all of the words or candidates available after 

OCR and Format Analysis. 

Note: To enable auto-completion for the current page only, select Use currently opened page only. 
 

About Workflow 

In Web Verifier / Verifier, you verify and correct batches failed in Runtime Server during Document 

Separation, Classification, or Extraction. 

 The workflow settings allow to define the processing of documents in Web Verifier / Verifier. 

 Each workflow step has an input and an output state. 

 The input state must match the failure output state defined for the corresponding workflow step in 

Runtime Server. 

 After a batch was successfully processed by the workflow step, Web Verifier / Verifier assigns the 

specified output state to the batch. 

 This output state must match the input state of the subsequent workflow step in Runtime Server. 
 

Specifying the Workflow Settings 

The workflow settings allow you to define the workflow of documents processed by Web Verifier. After each 



Oracle WebCenter Forms Recognition Web Verifier User's Guide 

13 

 

 

processing step, output states are assigned to batches, which distinguish success from failure. 

To modify the workflow settings, complete the following steps. 

1. In the Settings view, select the Workflow tab. 

2. To activate or deactivate a workflow step, click the corresponding button. 

 Document Separation 

 Classification Verification 

 Extraction Verification 

3. Optional. To add an input state, complete the following substeps. 

1. In the Input State field, right-click and then click Add State. 

2. In the Add State dialog box, type a new input state and then click OK. 

4. Optional. To remove an input state, in the Input State field, right-click and then click Remove State. 

5. Optional. To change an input state, complete the following substeps. 

1. In the Input State field, right-click and then click Change State. 

2. In the Change State dialog box, type a new value and then click OK. 

6. In the Input State field, select a value. 

7. From the Output State list, select a value. 

8. To enable WebCenter Forms Recognition to automatically extract data after the user manually classified 
a document, select Perform automatic extraction after manual classification. 

Note: This option is only available if the Output State of the Classification Verification workflow step 

matches the Input State of the Extraction Verification step. 

9. To skip valid documents when the user clicks the Next Document button or to disable access to 

already validated documents, select Disable navigation to valid documents. 

10. To navigate directly to the next invalid batch without displaying the confirmation release dialog box, 

select Hide batch release dialog. 

11. To open the first available invalid batch in the batch list, select By default open the first available 

invalid batch and not the selected one. 

Note: When you clear this option, the batch selected in the list opens. 

 

Specifying the General Settings 

To specify the General settings, complete the following steps. 

1. On the Options menu, click Settings. 

2. Optional. As an administrator, you can configure settings for different groups. Select Group 

Settings and then select a group from the list. 

Note: Other users configure their own settings by selecting My Settings.   

For more information, see About Groups. 

3. The project file contains the forms used to verify the extraction. To define the project that 

processes the documents, complete one of the following substeps. 

 To select a project file from the list, select Use project file and then select the required project 

from the Project list. 

The project loads after saving and returning to the Batch View. 

 To specify a project referenced in the batch control file, select Use batch specific project file. 



Oracle WebCenter Forms Recognition Web Verifier User's Guide 

14 

 

 

The project loads each time you open a batch and each time a batch opens for a different 

project. 

4. From the Job list, select the name of the job for which you want to process the documents. 

5. To select another language, from the Application Language list, select the required language. 

Web Verifier supports Chinese Simplified or Chinese Traditional, Danish, Dutch, English, 

French, Finnish, German, Italian, Japanese, Korean, Norwegian, Polish, Portuguese, 

Romanian, Russian, Spanish, Swedish, and Turkish. 

6. Optional. To automatically display newly generated batches with matching states, select 

Automatic Batch Refresh 

If the option is cleared, you can use the Refresh  button below the batch list. 

7. Optional. To skip all the valid fields and focus on the invalid fields only, select Tab through 

invalid fields only. 

Note: When you press Tab inside a table, the system tabs through invalid table cells only. This 

option also applies for tabbing backwards by pressing Shift + Tab. 

8. To speed up typing, enable Enable text typing auto-completion. When you start typing, auto- 

text completes the word, suggesting the best match among all of the words or candidates 

available after OCR and Format Analysis. 

About Exception Handling 

Use exception handling to deal with documents that fail in Web Verifier, such as documents with poor 

document quality or missing information. 

You can move such documents into an exception state to flag the batch for issues. 

Having a mechanism for handling unexpected errors allows users to remove the batch from their task list. 

Then, users can manually assign special states to documents. 

Defining Exception States 

When selecting a state, a menu command becomes available in the Verification View. The menu command 

allows for case-specific handling of various types of unforeseeable errors. The description represents the 

menu command’s label. 

To select an exception state and set its description label, complete the following steps. 

1. In the Settings view, select the Exception Handling tab. 

2. To select a state, in the Selected States column, select the corresponding check box. 

Note: The available exception states cover the range from 601 to 699. A batch state corresponds to the 

lowest document state within the batch. Routing batches using their exception state is only possible if 

the state for successful verification is greater than the one used for exceptions. 

 

3. To rename a description, right-click on the description and select New description. 

Note: This description represents the menu item in the Move Document to Exception State list in 
Verification View. 

4. In the Exception Handling dialog box, type the new description and then click OK. 

Note: The maximum character length for the description is 128. 

5. Select any of the following options. 
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Option Description 

Before moving a document 

to an exception state, save 

it automatically 

Select this option to save a document automatically before moving it to 

an exception state. 

 
Note: This applies to the current document only. 

Create new batches with 

documents marked for 

exception handling 

Select this option to move documents for exception handling to an 

exception batch. 

 Creates a batch for each exception code 

 Each batch receives a new batch ID 

 Documents from verified batches move to the same exception 

batch in Batch View 

 Batches release manually or automatically 

When this option is not selected, documents for exception handling 

stay in their batches. These batches keep their batch ID but receive a 

new name according to the state description. 

Automatically release all 

available pending 

exception batches that 

contain [XX] or more 

documents or older than 

[XX] minutes 

Select this option to release an exception batch once it contains more 

than [XX] documents or is older than [XX] minutes. This allows critical 

exception documents to process without waiting for manual 

intervention. Exception batches will also release when the user logs 

out. 

By default, set exception 

mode to Batch 

Select this option to change the scope of the command Move to 

Exception State on the Options menu to Batch automatically. 

Allow user selection of 

exception mode (Batch vs. 

Document) 

Select this option to enable the dynamic changing of the exception 

mode on the Options menu, document verification view. By default, 

this option switches on. Use this option together with the By default, 

set exception mode to Batch option to preserve a specific exception 

mode for the different user groups. 

Configuring Supervised Learning 

Supervised Learning allows users to nominate documents to the knowledge base job. Only users that have 

the SLV role assigned can access the Supervised Learning tab. 

1. In the Settings view, select the Supervised Learning tab. 

2. To enable Supervised Learning, select Activate Supervised Learning Workflow. 

3. To specify the job name used to keep track of the documents added to the knowledge base, from the 
Knowledge Base Job list, select a job. 

4. To apply global extraction on documents with low extraction rate, select Always automatically re- 

extract data for poorly processed documents. 

5. In the Copy document to global knowledge base section, select one of the following options. 

 Only if activated by the user: To copy the document to the global knowledge base, the user 
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needs to click the Nominate for Learning  button in the Document View. 

 Automatically if unclassified or more than [XX] % of fields are invalid: Select this option to 

copy documents automatically to the global knowledge base if they meet the configured 

criteria. 

Note: If Only if activated by the user is not selected, and the document does not meet the criteria to 

be copied automatically, the user can still copy a document to the global knowledge base by clicking 

in the Document View page. 

About Batch Filtering 

The batch filtering conditions affect the display of the batches. This is useful for finding a subset of batches 

in a large job or for limiting the user's activities. 

The filtering dialog box is accessible outside the settings dialog box, so that users without a SET role but with 

the FLT role can filter batches. Only users with the FLT role can configure filter conditions. 

Saving the settings applies to the current batch view and saves for the next sessions. 
 

Configuring Batch Filter Conditions 

To configure batch filter conditions, complete the following steps. 

1. On the toolbar, click the Batch Filtering  icon. 

Note: Users with the SET role can access the filtering window from the Settings. 

2. In the Batch Filtering Conditions dialog box, in the left pane, double-click to copy a field name to the 

Select Filter Condition field. 

3. In the right pane, double-click to copy an operator to the Select Filter Condition field. 

4. In the Select Filter Condition field, modify the condition according to your needs. 

To see only batches at a state of 550, add the following condition. 

[State]=550 

5. Optional. To clear the filter condition settings, click the Clear Condition button. 

6. Optional. Within the Group Settings section, administrators can easily define filter conditions for 

several user groups. 

1. Select a group from the drop-down list. 

2. Click Configure Filtering. 

3. Establish the filtering conditions and confirm by clicking Apply. 

4. Click Save to save your settings. 

Working with the Batch List 
 
The batch list is your work list and appears after starting Web Verifier. 

1. If the batch list does not display, on the toolbar, click the Show Batches  icon. 

2. Optional. To sort the batch list, click the column header by which you want to sort. 

3. To start verification, in the list of batches, click on the batch you want to verify. 

Depending on the status of the batch, either the classification or the extraction verification view opens. 
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Batch View Icons 

An icon displays in front of each batch to indicate the status. When an icon is not shown, the batch state is 

out of workflow. 
 

Symbol Status 

 

 Batch is complete and ready for export. 

 

 Batch requires a correction of the classification 

results. 

 

 Batch requires a correction of the extraction results. 

 

 Batch is locked by another user or application and is 

unavailable 

 

 Batch contains documents with exception statuses. 

To work on the batch, release it when it is 

unavailable. 

 

Batch View Columns 

Batch view columns display the following information about a batch. 

ID 

A number for uniquely identifying a batch. 

State 

An integer between 0 and 999 that indicates the progress of batch processing. The state also indicates 

whether the batch is ready for verification. 

 

Priority 

An integer between 1 and 9 that indicates the urgency for processing a batch. 1 is the highest priority and 

9 is the lowest. 

 

Name 

An arbitrary name that is easier to read than the batch ID. 

 
Folders 

Folders organize documents in a batch. The value in this column indicates the number of folders inside 

the batch. 

 

Documents 

The value in this column indicates the number of documents inside the batch. 

 
Last user/Module 
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This displays the most recent person or computer, and application to process the batch. 

 
Last Access 

Displays the latest processing date. 

 
Client 

The owner of the Forms Recognition, Contains N/A; not in use yet. 

 
External Group ID 

The group ID relates to the security of the batch. It is a unique ID that assigns batches to a user group. 

 
External Batch ID 

The external batch ID is the name of the Batch Group. You can use this ID to represent any piece of 

information you would like to associate with a batch, such as an external system ID or a storage box ID. 

 

Transaction ID 

Batches have transaction IDs to identify originators of batches of documents. This allows the developer 

to synchronize a new batch of documents with another external system. 

 

Transaction Type 

Transaction Types helps to identify the type of documents in batches. This allows the developer to 

synchronize a new batch of documents with another external system. 

Note: The External group ID, External Batch ID, Transaction ID, and Transaction Type columns, do not 

display by default. For more information, see "Additional Columns in Verifier or Web Verifier" in the 

Oracle WebCenter Forms Recognition Installation Guide. 
 

Batch View Toolbar Buttons 

The toolbar provides quick access to frequently used commands. 
 

Button Description 

 

 Displays a property sheet to configure Web Verifier. 

 

 Displays a dialog box to configure the batch filtering 

condition properties. 

 

 Clicking the arrow to the right of this button displays 

available filtering options for the list of batches. 

 

 Starts the verification of the current batch. 

Depending on the batch state, the batch will display 

in the classification window or in the indexing 

window. 
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 Displays the batch structure of the current batch. 

Selecting a document shows the document view, 

which provides an overview of the documents inside 

the batch. 

About the Document View 

The document view displays the structure of the batch and the document it contains. 

Selecting a document provides an overview of the documents inside the batch. 

You can use document view to investigate the documents in a batch. 

The levels of the hierarchy are as follows. 

 Batch 

 Folder 

 Document 

 Page 

Each document entry provides the following information. 

 ID: A number that uniquely identifies the batch, folder, or document. 

 State: An integer between 0 and 999 that indicates the progress of batch processing. The batch state 

corresponds to the lowest value of all folder states and the folder state corresponds to the lowest value of 

all document states. 

 The batch or folder Name is an arbitrary name that is easier to read than the ID. 

 Document Class: The document’s classification result. 

 Note: Depending on your access rights, the document view might list documents that are inaccessible. 

This is due to their input states which are out of the workflow you have access to. 

Working with the Document View 

In the document view, complete the following steps. 

1. On the toolbar, click the Show Selected Batch  icon. 

2. To expand or collapse a folder, double-click on it, or click the plus sign or minus sign next to it. 

3. Click on a page in the batch structure to display it in the right pane. 
 

Splitting or Appending a Document 

In the document list, you can cut multi-page documents into separate documents. You can also merge 

consecutive pages of documents into one multi-page document. Do the following, 

To split a multi-page document, complete the following substeps. 

1. Click the Show Selected Batch  button. 

2. To split a multi-page document, right-click a page and then click Cut pages into a new document. If the 
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cut operation is unavailable, switch back to the original sequence. Right click a page and then perform 

one of the following actions. 

Note: To mark a page as a cover page, right-click on the first page of the document and select Mark as 

cover page. 

3. To append a document to another, right-click the document to append, and then select Append this 

document to previous one. 

Main Toolbar Buttons 

The toolbar provides quick access to some frequently used commands. 
 

Button Description 

 

 Display a property sheet where you can configure 

Web Verifier. 

 

 Display a property dialog where you can configure 

the batch filtering conditions. 

 

 Display the Batch View. 

 

 Start the verification of the currently selected batch. 

Depending on the batch state, the batch is either 

displayed in the classification window or in the 

indexing window. A drop-down list allows users to 

verify the selected batch or verify the next invalid 

batch. 

 

 Display the available filters for the batch structure. 

You can select from among the following options. 

 All documents 

 Documents to Classify 

 Index Documents to Classify 

 Documents to Index 

 

 Display the first page of the selected batch or a 

single page of the selected document. 

 

 Display the first two pages of the selected batch 

horizontally or the first two pages of the selected 

document. 

 

 Display the first three pages of the selected batch 

horizontally or the first three pages of the selected 

document. 
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 Display the first two pages of the selected batch 

vertically or the first two pages of the selected 

document. 

 

Viewer Toolbar Buttons 

The viewer toolbar allows you to adjust the magnification used to display documents using the following 

commands. 
 

Button Description 

 

 Fits the document to window height. 

 

 Fits the document to window width. 

 

 Provides the best fit for an image. 

 

 Zooms in. 

 

 Zooms out. 

 

Document View Keyboard Shortcuts 

The following keyboard shortcuts are available in document view. 
 

Keyboard shortcuts Command 

Ctrl + 0 Print 

Ctrl + Shift + Home First document 

Page Down Previous document 

Page Up Next document 

Ctrl + Shift + End Last document 

Ctrl + 8 Append document 

Ctrl + 9 Cut document 

Ctrl + Enter Accept or reject next unsure page 

Ctrl + Space Select next unsure page 
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Ctrl + 1 Show batches 

Shift + Add Zoom in 

Shift + Subtract Zoom out 

Ctrl + Left Move image to left 

Ctrl + Right Move image to right 

Ctrl + Up Move image upwards 

Ctrl + Down Move image downwards 

Ctrl + R Rotate 

Ctrl + Home Display first page in document 

Ctrl + Page Down Display previous page in document 

Ctrl + Page Up Next page in document 

Ctrl + End Last page in document 

Ctrl + H Fit to height 

Ctrl + W Fit to width 

Ctrl + F Best fit 

Ctrl + J Increase image area 

Ctrl + K Decrease image area 

 

Working with the Verification View 

In the verification view, you correct the classification and extraction results. To display the Verification View, 

complete the following steps. 

1. Select a batch from the list that requires verification. 

2. Click the Verify Selected Batch  button. 

Depending on the state of the document, the classification or indexing window opens. 

3. Optional. To increase or decrease the image area, drag the vertical bar between the field pane and the 

image pane either to the right or left. 

4. If the classification window is displayed, from the class selection list in the lower pane, select the correct 

class. 

Note: You can also enter the first characters of the required class name to limit the number of classes 
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displayed. 

5.  If the indexing window is displayed, the document requires a correction of the extraction result. Correct 

the invalid fields. 

About the Classification and Indexing Results 

After classification, the result will be one of the following options. 

 Documents with no or a wrong classification display in the indexing window. 

 After assigning a class to documents without classes, the indexing window displays with fields ready for 

manual indexing. 

 Documents with the correct class but with invalid extraction results display in the indexing window ready 

for you to correct the extraction result. 

About the Indexing Window 

The indexing window displays the form defined in Designer and the current document. 
 

The Form Pane 
The form pane displays the form defined in Designer. A form area contains the following main elements. 

 Labels: Labels are captions that help users identify form fields, viewers and tables. 

 Viewer: A viewer contains pieces of document. 

 Fields: A field will display data and allow for entering or editing of data. Fields might be either a text field, 

table field, check box, list box, or a Yes/No selection. You can use fields to create check boxes and 

combo boxes. 

 

The Document Pane 
 

The document pane displays the current document or page. All words recognized during the OCR process 

are highlighted by default. To understand what the highlighting and box outlines represent, refer to the 

following list. 

 Red areas indicate the selection for the current field. 

 Yellow lines are candidates, however, another candidate is more likely. If the extraction result is invalid 

or wrong, these areas may point to the correct indexing data. 

 Gray lines highlight the unlearned lines in table correction mode. 

 Green lines highlight newly learned lines with high confidence. 

 Blue lines highlight newly learned lines with low confidence. 

Note: Colors may vary due to customization. 
 

The Input Pane 
 

The input pane below the document displays an enlarged part of the document that relates to the field. 

In the field below, you can modify the field content. 

Correcting Classification Results 
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To correct invalid classification results, complete the following steps. 

1. In Batch View, select a batch from the state column. 

Note: Use the arrow keys to navigate and select a batch. 
 

2. Press Enter to open the Verification View. The Verification View displays the first invalid document in 

Verify Mode. 

3. From the drop-down list in the lower pane, select the correct class and then press Enter. 

Note: If you know the correct class name, type the first characters and wait until the system 

automatically displays the full class name. 

The application validates the document and the updates the state. The next document requiring 

verification displays automatically. 

4. Repeat the previous steps for all documents. 

5. After verifying all the documents in the batch, perform one of the following actions. 

 To release the current batch and open the next batch that needs verification, select Verify the next 

invalid batch on the list. 

 To release the current batch and display the Batch View where you can select the next batch, 

select Close batch and return to the batch list. 

 To change verification forms, select Verify this batch with the next verification form. 

6. To confirm, click Yes. 
 

Reclassifying a Document Manually 

To assign a document to another class, complete the following steps. 

1. To open the classification window, from the Options menu, select Reclassify Document Manually. 

2. Correct the class and the press Enter. This displays the indexing window. 

Note: In most cases, index the documents manually because different classes have different sets of 

fields. 

About Processing Documents with an Obsolete Class 

Deleting a class will make the class obsolete. Often with Supervised Learning workflow, classes become 

obsolete because the global project's configuration deletes or just does not insert the class. 

The only way to process obsolete document classes is if the class still exists in the project that the document 

is processing with. Information saves internally about the former parent class assignment, which makes it 

possible to process obsolete document classes. 

About Manually Correcting Extraction Results 

To manually correct the extraction results, make sure to enable the extraction verification by checking the 

Workflow tab of the Web Verifier Settings or the Verifier Properties dialog box. 

If this is a regular task, apply the appropriate filter in Batch View using the menu command View > Batch Filter > 
Batches to verify, extraction only. 

 

Form Elements and Field Types 
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A form has three main elements: a label, a viewer, and a form field. 

From a form field, you can select a text field or table field. Using a text field or table field, you can create 

check boxes or combo boxes. The field types for validation include Read Only, Multi-line, Combo Box, and 

Check Box. You can also add a button to a form to fire actions. 

Elements of a form can include: 

Form fields 

Form fields display extracted data. You can also enter and edit data during manual indexing. You can 

use form fields to create check boxes and combo boxes. 

 

Labels 

Labels identify form fields, viewers, and tables. 
 

Viewers 

Viewers are sections of document areas, normally those that were extracted to fill fields or tables. 
 

Buttons 

Buttons fire project script actions. 

 
Tables 

Tables are extracted from documents. 

The following is a list of field types and their descriptions: 

Read Only 

When selected, information on a field is dimmed and cannot be selected or edited. 

Multi-line fields 

Required in the context of address analysis, but can also be useful in other cases. A multi-line field 

enables line wrap and displays a vertical scroll bar, if required. 

 

List Box 

A drop-down list that lists predefined strings related to the verification document. It can either show the 

nearest values automatically or show only selected values. 

 

Check Box 

A toggle selection for one of two choices of the data input for a field (for example: Yes/No). 

 
Correcting Invalid Results 

 
To correct invalid results, complete the following steps. 

1. In Batch View, check the state column to find a batch to verify. 

2. Start verifying. 

 In Verifier, use the arrow keys to select a batch and then press Enter. 

 In Web Verifier, click on the batch. 

The Verification View opens in Verify Mode, and the first invalid document displays. The application 
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places the cursor in the first invalid field. 

About Inserting Words in Fields 
 

To speed up verification, you can insert words to replace or append text. 

The method for inserting words depends on the availability of candidates. 

A candidate is one that matches the learned words for that field. It displays in green, with a border of green 

check marks if that visual indicator is enabled in Batch Options, when you select it after selecting the field. 

Non-candidates display in orange when selected. 

You can insert words in fields or table cells. You can append or insert words and use the mouse to append or 

replace the field. 

To use the Append feature, the selected word must appear on the same line as the existing cell text. If not, the 

selected word will replace the existing cell text. 

 Words that are candidates for cells: If the word belongs in a cell area, you can append or replace a 

word in a cell. The Append feature takes the current word behind the candidate and appends the cell text. 

It places the text in the best location, either to the right or left of the word, and in the cell location based on 

the text or location of the word. The word belonging to a cell area displays in green when selected. Or, 

you can replace the text. In the search region, word candidates are all words that are not covered (by 

location) by other table cells and that have the same beginnings as the whole text of the cell. 

 Words that are not candidates for a cell: If the word does not belong to cell areas, it displays in orange 

when selected. Even if it is not a candidate, you can append or replace the word. Appending places the 

text in the best location, either to the right or left of the word, by text or location of the word. For example, 

a cell named “C2658” might be appended by “number.” Or you can replace the cell text and location by the 

text and location of a word. 

About Editing Text Fields 
 

Verifier and Web Verifier include automated features for editing text fields that can speed up text entry and 

correction. 

You can use automatic character entry, when the auto-completion is selected in the form field Properties 

dialog box, to edit text fields and cells. Other options for character changes include multi-line fields, combo 

boxes, and check boxes. You can also insert and replace text in cells and fields, either in single words or 

blocks of text, using drag-and-drop or by double-clicking on the selected text. 

Multi-line fields are necessary for address analysis but can also be useful in other cases. A multi-line field 

enables line wrap and displays a vertical scroll bar, if required. To add a new line to a multi-line field press Ctrl 

+ Enter. 

A Combo box lists predefined strings related to the verification document. To aid in verification, you can 

select from the list of strings. 

The Check box provides an either/or option that toggles table data entry choices on and off. For example, with 

a Yes or No check box, checking Yes would bring up data entry related to the verification and unchecked for 

No would hide them. 

 

About Auto-Completion 
 

Auto-completion helps to speed up typing. When you start to type, auto-text completes the word, suggesting 

the best match among all of the words or candidates available after the OCR process and Format Analysis. 

For example, you can type the first two characters of a 20-character invoice. The auto-text feature finds the 
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best-matched candidate suggested by the Format Analysis engine and places it in that field. 

The auto-selected text also appears highlighted in the original document. Select whether a single-line or a 

multi-line text field should display. To override auto-completion, continue typing the desired text. 

The auto-completion feature for a header field should automatically select the best candidate, which works 

within Highlight Candidates mode. The viewer is only updated if the candidate appears once in the document; 

otherwise, when the word for the field is inserted by auto-completion, the viewer will be blank. 

Note: Auto-completion does not work on formatted text and characters incorrectly read by OCR. 

About Fields 
 

A field displays data and allows the user to enter or edit data. To understand fields and the different types, 

refer to the following lists. 

The following list explains the meanings of the colors and icons for both Web Verifier and Verifier. 

 A red frame for Web Verifier and a blue arrow  icon for Verifier indicates the current field. 

 A blue frame for Web Verifier and a green check mark icon for Verifier indicates a valid field 

extraction. 

 A red triangle in the right upper corner for Web Verifier and a red  icon for Verifier indicates a 

field that is needing validation because of its low confidence extraction. 

The following list explains the field types. 

 A user cannot edit or select a Read Only field. 

 An Auto-completion field enables the user to edit text by typing the first few letters of a word until 

best matching candidate appears. 

 A Multi-line field enables line wrap and displays a vertical scroll bar. This field type is a requirement for 

address analysis. 

 A List box contains a selection list to verify an item in a document. 

 Check boxes are toggle selections for data input that derive from form fields. 
Navigating Through the Fields 

To navigate through the fields, complete any of the following actions. 

 Use the mouse. This method does not affect the validation state of a field. 

 Press Tab. This method gets you to the next field, but not to the next document. This method does not 

affect the validation state of a field. 

Note: The order that the Tab key moves through the form is defined in field properties. For more 

information, see "Add a form field" in the Oracle WebCenter Forms Recognition Designer 

User's Guide. 

 Press Shift + Tab to go to a previous field. 

 Press Enter. This method validates the entire field or the next invalid character within a field. Once the 

field is correct, it validates and the focus moves to the next field that requires correction. This field may 

also be within another document. 

Using a Word that is a Candidate for a Field 
 

If the word is a candidate for a field, you can copy it into the field box. A candidate is a word that matches the 

learned selections for the field. To copy text to the field box, complete the following steps. 
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Prerequisite Ensure the word fits the format analysis rules for the specific field. 

1. On the document, click on the text you want to copy. A box appears around the word. 

2. Double-click on the text or right-click in the text, and then select Copy to Current Field. 

Note: You can insert only one candidate per field per document verification session. 
 

Using a Word That is not a Candidate for a Field 
 

Even if the word does not belong to any candidates for the field, you can append or replace a word with a new 

one. Appending places the text in the best location, either right or left of the word, by text or location of the 

word. Or you can replace the field text and location by the text and location of a word. A word that does not 

belong to any candidates for that field will display in orange when selected. For example, a field named “sales 

total” might be replaced by “invoice total.” To use a word that is not a candidate for field, complete one of the 

following options. 

 To append text with the new text, drag a box around the desired word. Double-click on the word in the 

box, or right-click in the document and select Append Field Text by Word. 

 To replace text, select the word with the mouse. A box appears around the word. Double-click it, or 

select Replace Field Text by Candidate in the shortcut menu. 

Note: You can insert only one candidate per field per document verification session. Make sure that 

this word fits the format analysis rules defined for that field. If not, the word is highlighted in orange 

(and with a border of orange exclamation marks if validity icons are enabled) to help distinguish it. If 

so, it would not be a good candidate for the field. 

Inserting Blocks of Text 
 

Inserting blocks of text is helpful when working with multiple data verification elements. To insert blocks of 

text, complete the following steps. 

1. On the document, drag over the text. 

2. Optional. Use the handles to adjust the selection. 

3. To replace the selected text in the field or table cell, complete one of the following substeps. 

 Drag the selection to the field or table cell. 
 Double-click on the selection. 

Finishing the Validation 
 

To finish validating after correcting a field, complete the following steps. 

1. Press Enter to validate. 

The cursor will automatically move to the next invalid field, regardless of whether the field is in the same 

or next invalid document. Leaving the document this way validates it automatically. 

2. Select the next step by clicking Yes or No. 

 Verify next invalid batch on the list. This releases the current batch and opens the next batch 

that needs verification. 

 Close batch and return to the batch list. This releases the current batch and displays the Batch 

View. 

 Verify this batch with the next verification form. Change verification forms using the next 

verification form. 

About Manual Indexing 
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Manual indexing is done if the Runtime Server was not configured to do the extraction step. Your input 

consists of batches with valid classification results, but no fields have been filled so far. 

For manual indexing, your Web Verifier workstation is configured as follows: 

 Classification verification is disabled. 

 Extraction verification is enabled. 

To determine your settings, check the workflow tab of the Web Verifier Settings dialog box. 

If you do this task regularly, you may want to apply the appropriate filter in the Batch View using the menu 

command View > Batch Filter > Batches to verify, extraction only. 

 

Indexing a Document Manually 

 
To index a document manually, complete the following steps. 

1. In Batch View, check the State column to find a batch you can verify and then select the batch. 

2. The Verification View opens in Verify mode and the first document displays. Web Verifier places the 

cursor in the first field. 

3. Enter the value for the first field. 

4. Press Enter to validate the entry. In the next field, proceed as described above. 

Note: The cursor automatically moves to the next field regardless of whether the field is in the same or 

the next invalid document. If you leave the document this way, it validates automatically. 

5. After indexing all the documents in the batch, the application prompts you to select one of the following 

choices. 

 Verify next invalid batch on the list. This releases the current batch and opens the next batch 

that needs verification. 

 Close batch and return to the batch list. This releases the current batch and displays Batch 

View where you can select the next batch. 

 Verify this batch with the next verification form. This changes verification forms, using the 

next verification form. 

6. To release the batch, click Yes. 
 

About Working with Tables 

You can verify tables in the same way you would correct an invalid header field. 

Additional methods to simplify manual table extraction, such as the Correct Table feature, are available. 

Traditional training and correction methods 

 
Inserting Candidate Words in Table Cells 

 

You can insert single words or append existing text in table cells. To insert words in table cells, complete the 

following steps. 

1. To select the text you want to insert in a table cell, complete one of the following actions. 

 Double-click on the word. 

 Right-click on the word in the image viewer and select the respective option. 

 If you have candidates, double-click the desired candidate to replace it. 
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2. To replace text with the new text, select Copy to current field. 

3. To append text with the new text, select Append Field Text by Word. 

Inserting Non-Candidate Words in Table Cells 

 

Even if the word does not belong to any candidates for the cell, you can insert single words, append or replace 

existing text in table cells. To insert words in table cells, complete the following steps. 

1. To append the selected text to the cell text, double-click the word or right-click in the document pane. 

2. Select Align & Copy to Current Field. 

3. To replace the cell text with the selected text, select the word, right-click and then click Copy to 

Current Field. 

About Correcting the Table Structure 

 

Under the table within the verification mask, there are buttons for modifying the table structure. The available 

commands are summarized in the following table. 
 

Button Command Description 

 

 Delete all rows Deletes all rows from the table. You will need to relearn the lines on the 

invoice. 

 

 Insert new row 

above 

Inserts an empty row above the current one. 

 

 
Delete 

selected row 

Deletes the current row. To select a row, click on its number. The 

appropriate line on the invoice is unlearned and loses its color highlighting. 

 

 Append Appends an empty row at the bottom of the table. 

 

Table extraction and correction 
 

About Lines 
 

The WebCenter Forms Recognition Table Extraction engine considers the following main types of the lines. 

Primary line 

A line that defines table structure. The engine applies advanced and precise similarity analysis for all 

primary lines. It is important that all primary lines are well-structured and that they look similar in many of 

the rows to extract. The engine easily supports an unlimited number of types of primary lines for one 

table definition. The primary line must contain at least four words. Otherwise, the engine will not learn it. 

In addition, the primary line must be the first line in the table row. 

 

Secondary line 

A line between primary lines. The engine applies smooth similarity analysis for these types of lines, 

which is possible because WebCenter Forms Recognition Table Extraction only searches the area 

between two neighboring primary lines. This allows the engine to extract data that varies widely, which 

often happens with multi- line descriptions. There is also no limit to the number of words in secondary 

lines, and no limit to the number of secondary lines. However, a document's page must have at least 
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one primary line; otherwise, secondary lines on this page are not extracted. 

 

Wrong line 

A primary line that is learned as a negative line sample. In other words, all lines classified by the engine 

as members of one particular “wrong” line class are not extracted. In principle, it is possible to learn an 

unlimited number of wrong lines, though the current restriction is that this will only take effect during in- 

document learning. Cross-document learning (that is, learning the whole document after all the fields are 

completely valid) may not automatically train the wrong lines. 

After it learns any type of line, the WebCenter Forms Recognition Table Extraction engine automatically 

creates and manages a new line class (cluster). Afterward, all lines in the document considered by the 

engine to be members of the line class (similar to the learned line sample) will be extracted, or not 

extracted in the case of “wrong” lines. 

It is possible to learn an unlimited number of different line classes. However, the overall quality may suffer if 

too many lines are learned. 

Learning lines can be applied in lines learning (or lines highlighting) mode. Mapping of the column data in the 

lines can be done in column mapping learning (or columns highlighting) mode. The user can switch between 

learning (highlighting) modes with the Switch Table Highlighting menu option in Verifier Options menu or with 

the context menu options Show Lines and Show Columns. 

About Learning Column Mapping 
 

When learning the mapping for columns, the user trains the engine on how the data from the extracted lines 

must be mapped to the user's table data. 

For primary lines, this mapping can be defined differently for different line classes. For example, if a user 

learned two different line samples that went to two different lines classes internally in one document, the user 

can then map “Unit Price” in the document to the “Unit Price” data column and the “Total Price” to the “Total 

Price” for the first line sample. For all lines of the second line type, the user can map “Unit Price” to “Total 

Price” and “Total Price” to “Unit Price.” For the next document, the WebCenter Forms Recognition Table 

Extraction engine will always use mapping rule #1 for the lines classified to the first line type and mapping 

rule #2 for the lines classified as the second line type. 

If you have several WebCenter Forms Recognition Table Extraction tables in one class, the learnset is 

shared between these tables. In other words, if you used interactive learning for one WebCenter Forms 

Recognition Table Extraction table, cross- document learning, which happens if the system added the 

document to the learnset after document validation, is applied for all WebCenter Forms Recognition Table 

Extraction tables in the document. 

About Correcting Fields in Tables Created with WebCenter Forms Recognition Table Extraction 
 

Any time you train a table interactively, complete the required training first and then manually verify the table. 

WebCenter Forms Recognition Table Extraction can train line types and column mapping for each type of 

line. 

When working with interactive table extraction, learn the lines before you map the columns. 

Because of the way interactive table verification works, you cannot manually delete data from a cell. Rather, 

if you want to discard cell data, unmap the column and re-extract the table to remap the column. Although it 

will seem as if you deleted the data, the data is still be there until you unmap the column. 

Using the Standard Method for Table Extraction 
 

The standard method for table extraction is the simplest way to use interactive WebCenter Forms 
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Recognition Table Extraction learning. To use the standard method, complete the following steps. 

1. Show the First Row Sample. 

2. Learn mapping. 

3. Learn missing lines. 

4. Adjust the mapping. 

5. Apply corrections. 

6. Learn the document. 

Showing the First Row Sample 

To show the first row sample, complete the following steps. 

1. To select the WebCenter Forms Recognition Table Extraction table, click any table field inside the table grid. 

2. Click the Correct Tables  button. 

3. Double-click the first row and select the Learn As Row function to show the row sample. 

Note: Turning off the Correct Tables button causes the loss of learned rows and columns. Turning the 

Correct Tables button back on leads to the loss of mapped table data. 

4. Optional. To learn a new line as a primary line, right-click any gray line on the document, and then select 

Learn Line. 

5. Optional. To learn a block of lines as primary lines, drag over the primary lines on the document, right- 

click, and then select Learn as Primary Line(s). 

6. Optional. To learn a block of lines as a table row, drag over the primary lines on the document, right- 

click, and then select Learn as Row. 

Note: Do not try to learn the rest of the missing secondary or primary lines now. If you attempt to train all 

different line samples now, you would need to learn the columns mapping separately for every line class. If 

you first learn the column mapping for the row you just learned, the next time you learn another line sample, 

the engine tries to apply existing mapping rules for the newly learned row automatically, significantly 

reducing the time to train the table. 

Learning Mapping 

To highlight the row you learned, complete the following steps. 

1. Right-click a line and select Show column. 

2. Mark the location of the first cell item in the row you learned. 

The system displays a special mapping control asking for the data column to extract the data to. 

3. Right-click the first cell item in a column. Choose Map Column, select the required data column, and 

then click the selection. 

4. Repeat the steps for the cell items in the first row. 

Learning Missing Lines 

To learn if text is missing from a row, complete the following steps. 

1. Switch to the lines highlighting mode. 

Note: Pressing Ctrl + Q switches the highlighting between three modes: cells, lines, and 

columns. Press Ctrl + Q twice to switch from columns learning to lines learning. 

2. Mark the next missing row and learn it as before. 

3. Repeat the steps for all rows on all pages, and then continue if nothing is missing. 
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Adjusting the Mapping 

To adjust the mapping of a missing or incorrect column, complete the following steps. 

1. Return to columns mapping learning mode. 

2. Find incorrect or missing mapping, and then correct the mapping. 

3. If you can’t map the missing columns, switch back to the lines highlighting mode, and then learn the row 

where the mapping is missing. 

4. Switch to columns highlighting. If the mapping is still missing, mark the missing part and map it. 

Note: The WebCenter Forms Recognition Table Extraction engine may determine the mapping automatically. 

5. Repeat steps until the data is completely extracted. The extraction results may not reach 100 percent. 

Applying Corrections 

To apply corrections and validate table fields, complete the following steps. 

1. Switch to cells highlighting mode and manually correct missing data and OCR errors. 

Note: Do not use interactive learning because every WebCenter Forms Recognition Table Extraction 
learning action reactivates extraction and replaces all your manual inputs instantly. 

2. To validate the table, press Enter. 

3. Optional. Click the Add Current Document to Local Learnset button to add the document to the 

learnset and then learn it, which is known as cross-document learning. Do this if the system did not 

suggest learning the document automatically. 

4. Note: The only requirement for cross-document learning is correctness and completeness of the 

table data to train. This means that location, content, and format of every cell item is accurate. 

Learning the Document 

After table learning and validation are complete, you may want to add this document to the 

learnset and then learn it. This is known as “cross-document” learning, in contrast with “in-

document” interactive Brainware Table Extraction learning. 

1. If you want to learn a document that the system did not automatically learn (the Add Current 

Document to local learnset button is not cleared), you can activate learning by clicking Add 

Current Document to Local Learnset. 

Note: The only requirement for cross-document learning is correctness and completeness of 

the table data to train. This means that location and content of every cell item should be 

correct. Also, ideally, the content of cell items should not be formatted. 
 

Advanced Learning with WebCenter Forms Recognition Table Extraction 
 

It is necessary to use secondary lines explicitly when a row begins on one page and ends on the next, or when 

learning an unmapped secondary line leads to an extraction. Refer to the following cases to understand more 

about these circumstances. 

Case 1: A row begins on one page and ends on the next 

If a table row begins on one page and ends on the next page, you must use the Learn as Secondary 

Lines function in lines learning mode to train missing secondary lines. 

In this case, these secondary lines appear right before the first primary line on the page. Mark all the 

secondary lines by right-clicking and selecting Learn as Secondary Lines. 

Note: Never use the Learn as Row function in this case, as this tells the engine that the first secondary 
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line is actually a new sample of primary line. As a result, the engine may split table data into new rows. 

Case 2: Learning of unmapped secondary lines leads to unwanted extraction 

Sometime the engine extracts data from secondary lines when it’s not a requirement for your project. In 

this case, not learning these secondary lines prevents unnecessary extractions. 

Use the Learn as Secondary Lines function instead of Learn as Row to learn certain lines. You can also 

Unlearn Lines to correct or adjust the extraction. 

Learning a Block of Secondary Lines 

To learn a block of secondary lines, complete the following steps. 

1. On the document, click and drag over the secondary lines of a multi-line row. 

2. Right-click on the selection and then click Learn as Secondary Line(s). 

3. Optional. Repeat the previous steps if lines did not extract. 

Unlearning a Line 

Discard previously learning for a particular line with the Unlearn Line function. To do this, WebCenter Forms 

Recognition Table Extraction uses a line sample, searches for the line type, and then removes the line type 

from the learnset. 

To unlearn a line, complete the following steps. 

1. Switch to Lines Learning mode. 

2. Right-click on the line you want to unlearn and then click Unlearn Line. 

Unlearned lines change from green to gray. 

Learning a Line as a Wrong Line 

Learning a wrong line means training the table to not extract particular lines. This applies to similar lines in the 

table. 

To learn a line as a wrong line, complete the following steps. 

1. Right-click on any learned line or click and drag over multiple lines. 

2. From the shortcut menu, select Learn as Wrong Line. 

Note: These steps affect similar lines, which appear in gray. 
 

About Manually Correcting the Automatic Document Separation 

To manually correct documents after automatic separation, navigate to Document Browsing mode. When 

the next batch opens, the system will automatically display the first uncertain page split or merge. 

When an entire batch returns to the “failed document separation” state, that means the automatic separation 

has at least one unsure page separation or merge. The Batch  Fail icon indicates that the batch will 

need a manual validation. 

Here, you have the following options. 

  Toggle the unsure status 

  Split the Document into two Separate Documents  

  Merge a Document with the Previous Document 

  Go to the Next Unsure Page  
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 Reorder the pages. 
 

About Toggling the Unsure Status 

 
Toggling the unsure status of a page sets the page to the manually accepted state or to the manually rejected 

state. 

There are three different states for page correction status. 

 The blue page icon indicates extraction with a high confidence. 

 The blue page icon with a red question mark indicates extraction with a low confidence. 

 The blue page icon with a green check sign indicates a manual correction or acceptance. 

 
Splitting the Document into two Separate Documents 

 
When cutting the document into two separate documents, the page where the cutting is occurring will become 

part of the “bottom document,” and all the other pages become the “top document.” The current page and the 

preceding page automatically get “manually accepted” page correction status. 

To split a document, complete the following step. 

 From the Document menu, select Cut Document. 

 
Merging a Document with the Previous Document 

 

A document can merge with the previous document. The current page and the last preceding page 

automatically get “manually accepted” page correction status. 

To merge a document, complete the following steps. 

1. Select a document. 

2. From the Document menu, select Append Document. 

 
Going to the Next Unsure Page 

 
This action selects the next unsure page to verify without changing any page states. The next unsure page 

has a red question mark. 

To proceed to the next unsure page, complete the following step. 

 From the Document menu, choose Select Next Unsure Page. 
 

Reordering Pages 

 
Reorder the pages within the document tree. To move a page to another position, complete the following 

steps. 

1. Perform a long left-click on the page. 

A tooltip appears indicating to specify the new position. 

2. Drag the page to the new position. 

A dynamic green position line indicates the new position. 

3. Click Yes on the reprocessing notification to complete the page reordering. 

Note: Reprocess the document after reordering the page. 
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About Page View Modes 

 
When verifying the accuracy of automatic page separation in Web Verifier, you can switch to a more 

convenient page view mode. 

There are four different page view modes. 

 Single page (default) 

 Two pages displayed vertically. 

 Two pages displayed horizontally. 

 Three pages displayed horizontally. 

In multi-page view, page presentation behavior is as follows: 

 In the two-page mode, the current page is on the right in the horizontal view and on bottom in the vertical 

view. 

 In the two-page mode, the first image shows the previous page of the current document or the last page 

of the previous document. 

 In the three-page mode, the current page is in the middle, the first image shows the previous page of the 

current document or the last page of the previous document. The third image shows the next page of the 

current document or the first page of the next document. 

Changing View Modes 

 

To change view modes, complete the following step. 

 From the View menu, select Multi-Page View, and then select an available option. 
 

Checking Entire Batches 

To check all the documents in a batch, complete the following steps. 

1. In Batch View, select a batch from the list that requires verification. 

2. Click the Verify Selected Batch  button. 

Verification View displays the first document requiring correction. 

3. To display the first document in the batch, click the First Document   button. 

4. Optional. You may encounter a document with incorrect classification. 

 For Verifier, press F7 to open the classification window. Next, select the corresponding entry from 

the drop-down list in the lower pane, and then press Enter to confirm. 

 For Web Verifier, select Reclassify Document Manually from the Options menu. Next, select 

the corresponding entry from the list at the bottom, and then press Enter to confirm. 

This displays the indexing window. 

5. Correct the extraction results by typing into the corresponding fields, and then press Enter to validate. 

 For Verifier, press F3 to return to the document. 

6. Go to the next document and repeat the previous steps. 

 For Verifier, press Ctrl + Alt + Page Down. 

 For Web Verifier, click the Next Document  button. 
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Classification Window Keyboard Shortcuts 

The following keyboard shortcuts are available in the classification window. 
 

Keyboard shortcuts Command 

Ctrl + 0 Print 

Ctrl + Shift + Home First document 

Page Down Previous document 

Page Up Next document 

Ctrl + Shift + End Last document 

Ctrl + 8 Append document 

Ctrl + 9 Cut document 

Ctrl + Enter Accept or reject next unsure page 

Ctrl + Space Select next unsure page 

Ctrl + 1 Show batches 

Shift + Add Zoom in 

Shift + Subtract Zoom out 

Ctrl + Left Move image to left 

Ctrl + Right Move image to right 

Ctrl + Up Move image upwards 

Ctrl + Down Move image downwards 

Ctrl + R Rotate 

Ctrl + Home Display first page in document 

Ctrl + Page Down Display previous page in document 

Ctrl + Page Up Next page in document 

Ctrl + End Last page in document 

Ctrl + H Fit to height 
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Ctrl + W Fit to width 

Ctrl + F Best fit 

Ctrl + J Increase image area 

Ctrl + K Decrease image area 

F7 Reclassify document manually 

F9 Move to exception state 

Ctrl + E Release exception batches 

Ctrl + T Correct table 

Ctrl + Q Switch table highlighting 

 

Classification Window Toolbar Buttons 

The toolbar provides quick access to some frequently used commands. 
 

Button Description 

 

 Not available in classification view. 

 

 Displays the Batch View. 

 

 Not available in classification view. 

 

 Displays the Document View. 

 

 The scope of this command depends on the 

Exception Mode set on the Options menu. Two 

options are available: Move Document to Exception 

State or Move Batch to Exception State. Clicking 

the arrow next to this button displays a list of 

exceptions. You can use these exceptions if you 

cannot correct a document at all—for example, 

because it belongs to none of the defined classes. 

Check with your administrator to determine which 

exceptions to use. Note that in order to avoid 

selection conflicts, only the toolbar button provides a 

list of exception handling states to choose from. The 

selection made here will also apply if you move a 

document to exception state by selecting the 

appropriate option within the Options menu. 
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 Highlights candidates – not available in classification 

view. 

 

 Fits the current image to the height of the window. 

 

 Fits the current image to the width of the window. 

 

 Fits the current image to the width or height of the 

window so that maximum enlargement is obtained. 

 

 Zooms in. 

 

 Zooms out. 

 

 Not available in classification view. 

 

 Keeps the established zoom settings on each 

document you view in the batch. 

 

 Moves image to the left. 

 

 Moves image to the right. 

 

 Moves image upwards. 

 

 Moves image downwards. 

 

 Displays the first page in document. This button is 

only enabled if the current document has more than 

one page. If you click on it, the first page is 

displayed. 

 

 Displays the previous page in document. This button 

is only enabled if the current document has more 

than one page. If you click on it, the previous page is 

displayed. 

 

 Displays the next page in document. This button is 

only enabled if the current document has more than 

one page. If you click on it, the next page is 

displayed. 

 

 Displays the last page in document. This button is 

only enabled if the current document has more than 

one page. If you click on it, the last page is 

displayed. 
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 Rotates current page clockwise. 

 

 Displays the first document in the batch. 

 

 Displays the previous document in the batch. 

 

 Displays the next document in the batch. 

 

 Displays the last document in the batch. 

Indexing Window Keyboard Shortcuts 

The following keyboard shortcuts are available in the indexing window. 
 

Keyboard shortcuts Command 

Ctrl + 0 Print 

Ctrl + Shift + Home First document 

Page Down Previous document 

Page Up Next document 

Ctrl + Shift + End Last document 

Ctrl + 8 Append document 

Ctrl + 9 Cut document 

Ctrl + Enter Accept or reject next unsure page 

Ctrl + Space Select next unsure page 

Ctrl + 1 Show batches 

Shift + Subtract Zoom in 

Shift + Add Zoom out 

Ctrl + Left Move image to left 

Ctrl + Right Move image to right 

Ctrl + Up Move image upwards 

Ctrl + Down Move image downwards 
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Ctrl + R Rotate 

Ctrl + Home Display first page in document 

Ctrl + Page Down Display previous page in document 

Ctrl + Page Up Next page in document 

Ctrl + End Last page in document 

Ctrl + H Fit to height 

Ctrl + W Fit to width 

Ctrl + F Best fit 

Ctrl + J Increase image area 

Ctrl + K Decrease image area 

F7 Reclassify document manually 

F9 Move to exception state 

Ctrl + E Release exception batches 

Ctrl + T Correct table 

Ctrl + Q Switch table highlighting 

 

Indexing Window Toolbar Buttons 

The toolbar provides quick access to some frequently used commands. 
 

Button Description 

 

 Not available in Indexing Mode. 

 

 Displays the Batch View. 

 

 Not available in Indexing Mode. 

 

 Displays the Document View. 
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 The scope of this command depends on the 

Exception Mode set on the Options menu. Two 

options are available: Move Document to Exception 

State or Move Batch to Exception State. Clicking 

the arrow next to this button displays a list of 

exceptions. You can use these exceptions if you 

cannot correct a document at all — for example 

because it belongs to none of the defined classes. 

Check with your supervisor to determine which 

exceptions to use. Note: In order to avoid selection 

conflicts, only the toolbar button provides a list of 

exception handling states to choose from. The 

selection made here will also apply if you move a 

document to exception state by selecting the 

appropriate option within the Options menu. 
 

 Highlights Candidates – Clicking this highlights all 

areas in yellow that were taken into account to fill the 

current field. 

 

 Fits the current image to the height of the window. 

 

 Fits the current image to the width of the window. 

 

 Fits the current image to the width or height of the 

window so that maximum enlargement is obtained. 

 

 Zooms in. 

 

 Zooms out. 

 

 If this button appears pressed down, the application 

always displays the document area that is 

associated with the currently selected field. 

 

 Keeps the established zoom settings on each 

document you view in the batch. 

 

 Moves image to left. 

 

 Moves image to right. 

 

 Moves image upwards. 

 

 Moves image downwards. 

 

 Displays the first page in document. 
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 Displays the previous page in document. 

 

 Displays the next page in document. 

 

 Displays the last page in document. 

 

 Rotates current page clockwise. 

 

 Displays the first document in the batch, and the 

application switches to Browsing Mode. 

 

 Displays the previous document in the batch, and 

the application switches to Browsing Mode. 

 

 Displays the next document in the batch, and the 

application switches to Browsing Mode. 

 

 Displays the last document in the batch, and the 

application switches to Browsing Mode. 

 

 Apply global extraction. 

 

 Copy to global knowledge base. 

 

 Correct tables. 

 

Printing a Document 

To print a document, complete the following step. 

1. Select File > Print. 

Note: This function is not available in the batch list view. 

2. In the Print dialog box, select the required settings and then click Print. 

Printing Verified Data Content 

To configure the print settings with the Print Setup dialog box, go to File > Print Setup. Here, you can select 

the field names and content to print. 

The order that the fields print depends upon the order of the fields in the Form Design mode of the Designer 

application. 

When a document prints, the header includes the document file name and the document class. 

The following print setup options are available. 

 Print image allows you to print pages of the document file. 

 Print form activates printing of the verification form. 



Oracle WebCenter Forms Recognition Web Verifier User's Guide 

44 

 

 

 Print hidden fields prints the visible fields on the current verification form and all the fields available in the 

document. 

 Print table fields is on by default. 

 Print column header on each printed table page is available only when the Print table fields option is on. 

 Always show the dialog when printing shows the Print Setup dialog box when users press print. 


